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Stacks, Buttons, Fields, and Cards
in HyperCard

Creating New Stacks

— Find the icon for "Home" or "HyperCard" and double-click on it.

If you are on the first card of the Home
stack the upper left portion of your screen
probably looks something like this.

If things don't look at all like this call one of
us over.

You will be taken to the first card of the "Home Stack". "Home" is one of the two parts of HyperCard that
makes everything run. It is the place you will most often start when you want to create something new in
HyperCard.
— From the File menu, select "New
      Stack..."

Release the mouse button and you will see this dialog box or one similar to it appear on the screen.

— Type in the name where it says "New stack name"
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— To create a stack which fills up the whole screen on a
large monitor,  select "Large" in the "Card size" option.

— Click on the "New" or just hit the "Enter" key and the next thing you'll see is your new stack. It will
appear as a blank screen.
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Making and Customizing Buttons

Buttons can be scripted to perform whatever function HyperCard itself can execute.

— From the "Objects" menu, choose "New Button."

When you release the mouse on "New Button," you are returned
immediately to the card and "New Button" appears in its center. The
new button will look like this:

The "marching ants" around the outside of the button show that the button has been "selected,”
which means you can do things with it.

If you don't see these "marching ants" around the button you want to work with, you will need to
select it.

— First, make sure you are operating with the "button" tool in effect.

— Pull down the "Tools" menu and make sure the
     button tool is hilited.

    This is the tool palette with the button tool hilited:
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— Grab a corner of the button with
     your pointer to resize the button
      and make it larger,

and smaller,

and back again:

— Double-click in the center of your button:

You'll
get a
"dialog
box"
which
says
"Button
Info." It
will
enable
you to
"script"
the
button
you have
created
to do
various
kinds of
things
for you.
This is
what the
dialog
box will
look
like.

You still probably have only one card in your HyperCard stack, but eventually you're going to be adding
more cards. For this task, we'll take you through the process of writing a scripts for two buttons. One will
perform the function of moving you to the next card in the stack; the other will move you to the previous
card. In the process, you will learn how to copy and paste, and then modify a button.
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— Put your pointer on the dialog box button labelled
     "Script" and click.

What will appear on the screen is
frame which has roughly the
appearance of a word-processing
document:

It will already have the initial commands, "on mouseUp" and "end mouseUp" supplied, and the cursor will
be blinking at you between the two commands. Between these two commands is where you will tell the
program what you want done when someone clicks the mouse on the button you have created.

In this case, let's have you
type in the command telling
HyperCard to take the user to
the next card:

Type these words 
into the script.

You may close and save your script by hitting the "Enter" key (Note:
NOT the return key). After which, you are probably looking at a
button on your card that looks something like this:

and you still have the button tool selected.
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The next 2 steps will be to: 1) Put a "forward arrow" icon on the button.
2) Remove the name from the button.

To do
this,
double-
click the
button
with your
mouse
and the
button
dialog
box will
re-appear
on your
screen.

— Click once on the "Icon"  button:
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— From the
Icon menu
choose a
forward
arrow that
you like:

    The result will be a button in your stack which has a
     forward arrow and a name, "New Button."

You may want to get rid of that name. There are two things you could do:

1. Change the name to something like "Next Page", or
2. Remove the name altogether.

To change the name, do this:

1. Type something like "Next  Page" into "Button Name."
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2. Click on "OK." and you should find that  the button on your
     screen now looks like:

        

To remove the name altogether, use your mouse to un-check the Show
Name of your button.

       
so that the "X" disappears:

       
 Then click "OK" or simply hit the "Enter" key. Now, your button looks
like this:
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Now move it to the lower
right corner of your card:

If you have the button tool
selected, all you do is "grab"
the button, move it and drop
it where you want it.

       

Now move it to the lower
right corner of your card:

and grabbing a corner with
your pointer, make the
button smaller so that your
screen now looks something
like this:

            

The next step is to have you copy and paste the button you have just created and modify it so that it will
move you back one card.

1. Choose the button tool and select the forward arrow button. You should see the "marching ants" around
     it.

2. Type + C to copy the button and then + V to paste it. Things won't look any
different after you've done the copy and paste because the new button looks exactly like the first; besides,  it
is sitting right on top of the first one.

3. The newest button is the one which is now selected, so you can move it by grabbing it and dragging it
two where you want it. Since you want this button to move the user back one card, you probably want 
it to be placed in the lower left corner of the card. Drag your newly copied button to the lower left corner
of the card.
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As you can see, the new button needs modification to make it work the way you want it to. With the button
tool still chosen, double click the button so that you can change its script and change its icon.

 If the button tool is still chosen and the new button at the bottom
left of your card is still selected, then double-click it to open the
dialog box and click once on the script button.        

When you have your button
script open enter command
to "go prev(ious card):

Hit the "Enter" key to close
the script box and save the
scrip

       

Your script 
should look 
like this.

Now the button looks the same on the card but its function has
changed. If you were to click it, it would move you to the previous
card in the stack. It is now a good idea to change the icon on the
button to coincide with the button's function. With the button tool
chosen and the button selected, double-click on the button and wait
for the dialog box to come up. Choose "Icon."

       

 Choose the left-facing arrow for your icon.

Click "OK" or hit the "Enter" key.
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Now the card looks like this:

Choose the browse tool to 
make the marching ants 
around this button 
disappear.

At this time you probably still have only one card in your stack, so these two buttons don't really do
anything useful. That will come later when you add cards to the stack.

Right now you are simply designing the basic look of the cards which will appear in your stack.

One of the important functions of your HyperCard stack will be to provide information to the stack's users.
Information is usually supplied in the form of text and, in HyperCard, text is ordinarily contained in objects
called "text fields.”
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Making and Customizing Text Fields

It is mainly text fields which convey
information in your HyperCard stacks. At
this point, you are probably looking at a
stack that still has only one card and two
buttons which don't yet perform any useful
function. Now, you should think about the
things you might want to put on this card in
the way of text.

So, now, why don't you think about the things you might want to put on this card in the way of text.

Maybe a text field that gives a title up here.

Down here, a field that gives instructions 
to the users.

Here, a button where the user can 
choose an answer. 

Here, another button where the 
user can choose an answer. 

Here, a field that prompts the user.
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So, let's start by making a title for this stack of cards. We'll put it in the upper left corner (or the top center).
You can title it anything you want. The important thing is seeing how text fields are created.

—  Pull down the "Object" menu of
  HyperCard and choose “New Field."

When you release the mouse
button. you will have a new
field in the center of your
card with the marching ants
going around it indicating
that you are working with
the field tool and that the
newest field on the card has
been selected. Things should
look like this:

The field as you see it before you is not fixed; it can be modified in a number of ways, for example:

• location on the card
• size
• type of border
• size of the type and the font
• locked or unlocked
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First change the location of the new
field.

Using the pointer, grab the center of
the new field and drag it up to the
upper left corner of your card:

Now grab the lower right corner of the still-
selected field with your pointer and drag it
into a shape that looks something like this:.

 When a new field
comes up, it always
appears generically
with a 12 point
Geneva font, which
is a pretty plain
thing. You may want
to change that. In
this case, we're
working on the title
of the card so
probably we want
something at least a
little larger than 12-
point. To make this
kind of change in
your field, double
click the selected
field to see the "Field
Info" box.
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—  You're interested in the button labeled "Text Style". Click on it to
     determine the font, alignment, and text size you want in your title field.

The
dialog
box
should
look like
this:

 —  Click "OK" to put your selection into force. You can change anytime you wish by once again...

• selecting the field.
• double-clicking it to get the dialog box
• selecting text style from the menu

—  Choose the browse tool from the Tools  menu in order to be
       able to type into the text field.

—  Type something into your title field and see what it looks like.
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You will notice that this field has a thin line around it. That is
because the default style for a new field in HyperCard is
"rectangle', which means a box with a thin line around it. You can
change that. The options are available under the field's dialog box.

—  To get back to that dialog box choose the  field tool:

Double-
click on
your field
to go to
the dialog
box.

—  Pull down the "Style" menu:

I happen to choose shadow here for my title field. Release the button on your selection and click "OK" or
hit "Enter" to close the dialog and put your choices into effect. The title field on my card now looks like
this:
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Make one or two more fields on your card and then go on to:

Creating New Cards

If you have just created a stack, it contains only the card you're looking at. For any practical educational
purpose you'll probably want more cards in your stack. Making them is easy.

The quickest way is to type + N.

You may also Choose "New Card" from the "Edit"
menu:

When you release the mouse button on "New Card", things may look like they haven't changed, but they
have. What you are now looking at is your new card. If you are thinking of a HyperCard stack as if it were
a deck of cards, then you are now viewing the second card in the deck.

There are several ways of getting from one card to another. One of them is to use the "Arrow Keys" on
your keyboard. Depending upon the settings on your HyperCard program, the arrow keys may or may not
work consistently. You might want to look at HyperCard Help to find out the details.

Another way to move from card to card is to use the + 2  key combination to go to the previous

card or  + 3 key combination to go to the next card. Nevertheless, it is usual, and helpful for
your student users if you can provide buttons for them to click to move forward and backward.


